
The Complete Herman Collection Overview

The Complete Herman Collection is a compendium of twenty years of Herman cartoons. With this 
multimedia application you can view cartoons and cartoon strips, create a slide show and create 
Windows wallpaper using your favorite Herman cartoon. A Herman screen saver has also been 
installed on your system but must be configured separately.

The cartoons are divided up into several collections that allow you to easily locate the types of 
cartoons you want to view. Cartoons on a theme or of a particular type are grouped together. You can 
also view cartoons from any or all of the eight Herman treasuries.

The cartoons are displayed in an easy to use viewer that allows you to view the cartoons one at a 
time. The viewer also allows you to save the cartoons to a bitmap file on your hard disk or copy them 
to the Windows Clipboard for use in other applications.

{button ,AL(`Getting Started;Keyboard Short-cuts;The Complete Herman Collection main 
window')} Related Topics

{button ,AL(`Installing The Complete Herman screen saver',1)} Installing the Complete Herman 
screen Saver



Getting Started

As soon as The Complete Herman Collection starts, you can begin to view the cartoons. The main 
window has forward and reverse browser buttons in the lower left and right corners of the window. 
This is the easiest way to view the cartoons. Click the right browser button to move forward through 
the collection or on the left browser button to move backwards. By default, you're viewing the 
collection of color, single panel cartoons.

Choose a collection to view

You can continue to view the color cartoons or you can switch to another collection. Choose the 
Browse Wizard menu. The Wizard    brings you to a dialog which allows you to select the collection of 
cartoons you want to view. Click the button that identifies the collection. Depending on the collection 
you select, you may go to the first cartoon in that collection or you may go to a second wizard page. If 
you go to a second page, make a selection and click the Finish button. 

Exiting from The Complete Herman Collection

When you exit from The Complete Herman Collection, you're prompted to save your current location 
in the collection. If you say yes, you'll be able to begin viewing the cartoons from this same cartoon 
the next time you start The Complete Herman Collection.

{button ,AL(`Print... command (File menu);To load a bookmark;To start a slide show;Wallpaper 
command menu')} Advanced topics



Save as... command (File menu)

Commands: Save As...

Shortcuts: N/A

The Complete Herman Collection allows you to save the Herman cartoons into a Windows Bitmap 
file. The Bitmap files have a BMP file extension.

To save a Herman cartoon to a Windows Bitmap file:

1. Display the cartoon you want to save.

2. From the File menu, choose the Save As... command.

3. Type the name you want to give the bitmap file.

4. Click the OK button.

{button ,AL(`Copy command (Edit menu)')} Related Topics



Print... command (File menu)

Commands: Print...

Shortcuts: Ctrl+P

The Complete Herman Collection allows you to print the Herman cartoons for you and your friends to 
enjoy.

To print a cartoon:

1. Display the cartoon you want to print in the viewer.

2. From the File menu, choose the Print command.

3. Set the print options, including any changes to the printer setup, and then click the OK button.

{button ,AL(`Print Preview command (File menu);Print Setup... command (File menu)')} 
Related Topics



Print Preview command (File menu)

Commands: Print Preview

Shortcuts:

You can preview the Herman cartoon before you begin printing. In the preview window, magnify the 
information on the page, and close the preview. If the layout is correct, you can print directly from the 
preview window.

To preview a cartoon for printing:

1. Display the cartoon you want to print.

2. From the File menu, choose the Print Preview command.

{button ,AL(`Print Setup... command (File menu);Print... command (File menu)')} Related 
Topics



Print Setup... command (File menu)

Commands: Print Setup...

Shortcuts: N/A

Most printers include options for choosing a default printer, paper orientation, and paper selections. 
However, the options provided when you choose the Print Setup... command depend on the 
capabilities of your printer. For information about these options and settings, see the documentation 
provided with your printer.

Printer setup options usually identify the printer that's used by default and list other printers which are 
available for temporary selection.

Typically, printer setup options also let you choose the paper orientation: landscape or portrait. The 
landscape setting prints information horizontally on the page. The portrait setting prints information 
vertically on the page.

The paper settings let you choose the paper size and the source, which is typically the print tray in 
which the selected paper size is located.

To set print options:

1. From the File menu, choose the Print Setup... command.

2. Select the printer setup options and click the OK button.

{button ,AL(`Print Preview command (File menu);Print... command (File menu)')} Related 
Topics



Exit command (File menu)

Commands: Exit

Shortcuts: Alt+F4

If you want to stop The Complete Herman Collection from running on your system, you can exit the 
application. 

To exit The Complete Herman Collection:

1. From the File menu, choose the Exit command.

You may also run other applications and leave The Complete Herman Collection running in the 
background so that you can quickly refer back to it at any time.

To leave The Complete Herman Collection running in the background:

1. From the System menu, choose the Minimize command.



Copy command (Edit menu)

Commands: Copy

Shortcuts: Ctrl+C

The Copy command allows you to copy the currently displayed Herman cartoon to the Windows 
Clipboard. You can paste the duplicate icon into any application that supports pasting graphics from 
the clipboard. 

To copy a cartoon to the clipboard:

1. Display the cartoon you want to copy.

2. From the Edit menu, choose the Copy command.

{button ,AL(`Save as... command (File menu)')} Related Topics



Browse Wizard menu command

Commands: Browse Wizard

Shortcuts: N/A

The Complete Herman Collection allows you to browse through different collections of Herman 
cartoons. You can choose to view the cartoons by category, treasury, your collected favorites, color 
strips, color single frames, or all cartoons.

Collection name Displays cartoons that are...

Category based on a theme such as medical, sports, etc..

Treasury from one of the eight treasuries that were published as books.

Favorites from a collection of favorites that you create.

Strips multiple panels in full color.

Color single panel in full color.

Bookmark from the collection of cartoons to which you added a bookmark.

All Cartoons from all of the collections above.

To view cartoons from a collection:

1. Choose the Browse Wizard menu.

2. From the Browse Wizard dialog box, choose the collection that contains the cartoons you want to 
view.

3. For more detailed information on each of the options, see the on-line help.

{button ,AL(`Add To Favorite command (Favorite menu);Save Bookmark... command 
(Bookmark menu)')} Related Topics



Save Bookmark... command (Bookmark menu)

Commands: Save Bookmark

Shortcuts: N/A

As you're looking through The Complete Herman Collection, you may need to exit from the collection 
or you may want to mark a favorite cartoon. Bookmarks allow you to return directly to a specific image 
any time you run The Complete Herman Collection.

To insert a bookmark:

1. Display the cartoon you want to mark with a bookmark.

2. From the Bookmark menu, choose the Save Bookmark... command.

{button ,AL(`Enter Name For Bookmark;Exit command (File menu);Load Bookmark... 
command (Bookmark menu);Slide Show command menu')} Related Topics



Load Bookmark... command (Bookmark menu)

Commands: Load Bookmark

Shortcuts: N/A

As you're looking through The Complete Herman Collection, you may need to exit from the collection 
or you may want to mark a favorite cartoon. Bookmarks allow you to return directly to a specific image 
any time you run The Complete Herman Collection. After you’ve saved a bookmark using the Save 
Bookmark... command, you can return to the same cartoon using the Load Bookmark... command.

To load a bookmark:

1. From the Bookmark menu, choose the Load Bookmark... command.

2. From the Bookmark list, select the bookmark you want to load.

3. Click the OK button.

{button ,AL(`Exit command (File menu);Save Bookmark... command (Bookmark menu);Select 
Bookmark To Open')} Related Topics



Save Bookmark on Exit command (Bookmark menu)

If the Save Bookmark on Exit command has a check mark beside it, The Complete Herman Collection 
prompts you to save your current position in the collection whenever you exit from the software. If this 
command doesn't have a check mark beside it, your current location in the collection won't be saved 
and you'll have to browse through the collection again until you reach the same point.

To save your location when you exit:

1. From the Bookmark menu, make sure the Save Bookmark on Exit command has a check mark 
beside it. If it doesn't, choose this command and the feature will be enabled. If the command 
already has a check mark, you're prompted to save a bookmark name when you exit.

{button ,AL(`Load Bookmark... command (Bookmark menu)')} Related Topics



Add To Favorite command (Favorite menu)

Commands: Add to Favorite

Shortcuts: N/A

As you enjoy each of the cartoons in The Complete Herman Collection, you'll undoubtedly find some 
that you consider the funniest. You can add these to your own collection of favorites for viewing later 
on. You can use your Favorites collection whenever you run a slide show or browse through the 
cartoons manually.

To add a cartoon to your collection of favorites:

1. Display the cartoon you want to add.

2. From the Favorite menu, choose the Add to Favorite command.

{button ,AL(`Remove From Favorite command (Favorite menu);Slide Show command menu')} 
Related Topics



Remove From Favorite command (Favorite menu)

Commands: Remove from 
Favorite

Shortcuts: N/A

As you enjoy each of the cartoons in The Complete Herman Collection, you'll undoubtedly find some 
that you consider the funniest. You can add these to your own collection of favorites for viewing later 
on. You can use your Favorites collection whenever you run a slide show or browse through the 
cartoons manually.

To remove a cartoon from your collection of favorites:

1. Display the cartoon you want to remove.

2. From the Favorite menu, choose the Remove Favorite command.

{button ,AL(`Add To Favorite command (Favorite menu);Slide Show command menu')} Related 
Topics



Slide Show command menu

Commands: Slide Show

Shortcuts: N/A

To make viewing easier, you can set The Complete Herman Collection to automatically display a 
series of cartoons. The slide show displays cartoons sequentially at a time interval you select. 

When you select Slide Show, you’re prompted to enter the viewing time for each cartoon. The time 
can be from 1 to 99 seconds; however, the minimum time to display the cartoons depends on the 
speed of your computer and the speed of your CD-ROM drive. After you specify the viewing time, 
you're prompted to select the cartoon category that you want to include in the slide show. Once 
you’ve selected a category, you can sit back and watch the show.

To start a slide show:

1. Click the Slide Show menu.

2. Type the number of seconds you want to view each cartoon and click OK.

3. Select the collection from which you want to view the cartoons and click OK.

To stop a slide show:

1. Press the Esc key.

{button ,AL(`Add To Favorite command (Favorite menu);Save Bookmark... command 
(Bookmark menu)')} Related Topics



Wallpaper command menu

Commands: Wallpaper

Shortcuts: N/A

You can use any of the Herman cartoons as your Windows 95 wallpaper. When you find a cartoon 
you would like to use, simply click the Wallpaper menu. A Windows Bitmap file, named 
HERMANWP.BMP, is created in the directory where you've installed Windows 95 and your wallpaper 
is immediately changed to the selected cartoon. Each time you change cartoons, the new cartoon is 
written to the HERMANWP.BMP file.

To change the system wallpaper:

1. Click the Wallpaper menu.

2. Click OK.



Contents command (Help menu)

Commands: Contents

Shortcuts: F1

Choosing the Contents command displays a list of topics available in this Help file.



Using Help command (Help menu)

Commands: Using Help

Shortcuts: N/A

If you require    help on performing any function in The Complete Herman Collection, extensive on-line 
help is included in the software. If you're unsure of the operation of any menu command or the 
procedure for a specific function, the on-line Help in The Complete Herman Collection can probably 
help you.

Method of 
accessing Help

Type of information provided

Help menu Choosing Contents from the Help menu 
displays the Help file's table of contents and 
allows you to access the Help file's Index 
and full text search. Use the Help menu for 
overviews and explanations of procedures.

F1 Key Provides help on the currently selected 
object or dialog box. For example, if you 
select a menu command and press F1, for 
information on the use of the selected 
command is displayed.

Shift+F1 Keys Provides a context-sensitive help cursor 
(Show cursor). For example, you can press 
Shift+F1 and click on a menu command for 
information on the use of the selected 
command.

Help button Provides an overview of the current dialog 
box or window.

To display Help for a specific command:

1. Highlight the command.

2. Press the F1 key.

To display Help for a specific dialog box:

1. Press the Help button on the dialog box or press the F1 key.

To display Help for window elements such as buttons and list boxes: 

1. Press the Shift and F1 keys at the same time and then click the element.



About Herman... command (Help menu)

Commands: About

Shortcuts: N/A

Displays version information about The Complete Herman Collection’s Reader.

To display the version of The Complete Herman Collection that you're using: 

1. From the Help menu, choose the About Herman... command.



Keyboard Short-cuts

Function Keyboard Short-
cut

Copy 
{button ,AL(`Copy 
command (Edit 
menu)')} 

Ctrl+C
Ctrl+Insert

Print 
{button ,AL(`Print... 
command (File 
menu)')}

Ctrl+P

Help 

Context-sensitive 
Help 

F1

Shift+F1

Repeat browse 
button

Space



System menu is activated by clicking on the Herman icon in the upper-left corner of The Complete 
Herman Collection window. It contains commands which allow you to restore, move, size, minimize, 
maximize and close The Complete Herman Collection window.



Minimize reduces the window to an icon. This action occurs when you either choose the Minimize 
command from the System menu or click the left button in the upper right-hand corner of the window.



Maximize increases the window to the size of your screen. This action occurs when you either 
choose the Maximize command from the System menu or click the right button in the upper right-
hand corner of the window. The Complete Herman Collection can’t be maximized.



Size allows you to drag a border on the window to resize it. The Complete Herman Collection window 
can’t be resized.



Close shuts down the window.



Restore returns the window to its original size. The Complete Herman Collection can't be resized or 
maximized so the Restore function isn't required.



Move allows you to drag the window to a new location.



Switch To displays the Task List from which you can activate another application.



Caption bar displays the name of the current directory contents and pane.



Scroll bars advance the information in the current panel.



Enter Name For Bookmark

The Enter Name For Bookmark dialog box is displayed when you choose the Save Bookmark 
command from the Bookmark menu. It allows you to assign a name to the currently selected cartoon 
so that you can easily return to this same location in the collection. Type a descriptive title in the 
Name field and click the OK button.

Name field specifies a name that marks the current cartoon. You can return to this cartoon again 
using the Load Bookmark command.

Cancel button exits from the Enter Name For Bookmark dialog box and discards the bookmark name 
you typed.

OK button exits from the Enter Name for Bookmark dialog box and attaches the name you typed for 
the bookmark to the current cartoon.

{button ,AL(`Save Bookmark... command (Bookmark menu)')} Related Topics



Specifies a name that marks the current cartoon. You can return to this cartoon again using the Load Bookmark command.



Exits from the Enter Name For Bookmark dialog box and discards the bookmark name you typed.



Exits from the Enter Name for Bookmark dialog box and attaches the name you typed for the bookmark to the current cartoon.



Select Bookmark To Open

The Select Bookmark To Open dialog box is displayed when you choose the Load Bookmark 
command from the Bookmark menu. It allows you to return to a specific cartoon in the collection by 
selecting the name of the appropriate bookmark from the Name list and choosing the OK button. 

If you want to remove a bookmark from a cartoon, select the bookmark from the Name list and click 
the Delete button.

Name list box lists the bookmarks that you’ve added to cartoons.

Cancel button exits from the Select Bookmark Top Open dialog box and returns to the current 
cartoon.

Delete button removes the selected bookmark from the list. The cartoon that the bookmark marked 
will no longer be marked.

OK button exits from the Select Bookmark To Open dialog box and displays the cartoon indicated by 
the bookmark.

{button ,AL(`Load Bookmark... command (Bookmark menu)')} Related Topics



Lists the bookmarks that you’ve added to cartoons.



Exits from the Select Bookmark Top Open dialog box and returns to the current cartoon.



Removes the selected bookmark from the list. The cartoon that the bookmark marked will no longer be marked.



Exits from the Select Bookmark To Open dialog box and displays the cartoon indicated by the bookmark.



Browse Wizard

The Browse Wizard dialog box is displayed when you click the Browse Wizard menu. It allows you to 
select the types of cartoons you want to view. Choose the button that best represents the type of 
cartoons you want to view and the Wizard will either display a second page to further refine your 
choice or will return to the main window to display the cartoons.

All Cartoons button selects all the cartoons for viewing.

Category button displays another wizard page which allows you to select cartoons that follow a 
specific theme such as medicine or sports.

Treasury button displays another wizard page which allows you to select the cartoons from one or 
more of the Herman treasuries.

Favorite button selects your collection of favorite cartoons for viewing.

Strips button selects the collection of multiple panel, color cartoon strips for viewing.

Color button selects the collection of single panel, color cartoons for viewing.

Bookmark button selects only the cartoons that you’ve marked with bookmarks.

Cancel button exits from the Browse Wizard and returns to the cartoon in the collection that you 
were previously viewing.

{button ,AL(`Browse Wizard menu command;Slide Show command menu')} Related Topics



Selects the collection of cartoons that you want to view with the browse buttons.



Selects all the cartoons for viewing.



Exits from the Browse Wizard dialog box and returns to the cartoon in the collection you were previously viewing.



Displays another wizard page which allows you to select the cartoons from one or more of the Herman treasuries.



Selects your collection of favorite cartoons for viewing.



Selects the collection of multiple panel, color cartoon strips for viewing.



Selects the collection of single panel, color cartoons for viewing.



Selects only the cartoons that you’ve marked with bookmarks.



Exits from the Browse Wizard Dialog box and returns to the cartoon in the collection that you were previously viewing.



Select Category

The Select Category dialog box allows you to select a group of cartoons that are based on a theme. 
Select the category of cartoons you want to view and click the OK button.

Aliens button selects cartoons that are based on the theme of aliens.

Animals button selects cartoons that are based on the theme of animals.

Art button selects cartoons that are based on the theme of art.

Crime button selects cartoons that are based on the theme of crime and criminals.

Domestic button selects cartoons that are based on the theme of domestic life.

Everyday button selects cartoons that are based on the theme of everyday life.

Festive button selects cartoons that are based on the theme of festive occasions.

Food button selects cartoons that are based on the theme of food.

History button selects cartoons that are based on the theme of history and historical events.

Kids button selects cartoons that are based on the theme of kids.

Marriage button selects cartoons that are based on the theme of marriage.

Medical button selects cartoons that are based on the theme of medicine.

Money button selects cartoons that are based on the theme of money.

Motoring button selects cartoons that are based on the theme of automobiles and motorized travel.

Physical button selects cartoons that are based on the theme of being big and being small.

Science button selects cartoons that are based on the theme of science.

Shopping button selects cartoons that are based on the theme of shopping.

Sports button selects cartoons that are based on the theme of sports.

Travel button selects cartoons that are based on the theme of travel.

Work button selects cartoons that are based on the theme of work.

Back button returns you to the first Browse Wizard page.

Finish button accepts your category selection and takes you to the main window to view the 
collection.

{button ,AL(`Browse Wizard')} Related Topics



Select a category of cartoons that you want to view.



Selects cartoons that are based on the theme of aliens.



Selects cartoons that are based on the theme of animals.



Selects cartoons that are based on the theme of art.



Selects cartoons that are based on the theme of crime and criminals.



Selects cartoons that are based on the theme of domestic life.



Selects cartoons that are based on the theme of everyday life.



Selects cartoons that are based on the theme of festive occasions.



Selects cartoons that are based on the theme of food.



Selects Cartoons that are based on the theme of history and historical events.



Selects cartoons that are based on the theme of kids.



Selects cartoons that are based on the theme of marriage.



Selects cartoons that are based on the theme of medicine.



Selects cartoons that are based on the theme of money.



Selects cartoons that are based on the theme of automobiles and motorized travel.



Selects cartoons that are based on the theme of being big and being small.



Selects cartoons that are based on the theme of science.



Selects cartoons that are based on the theme of shopping.



Selects cartoons that are based on the theme of sports.



Selects cartoons that are based on the theme of travel.



Selects cartoons that are based on the theme of work.



Returns you to the first Browse Wizard page.



Accepts your category selection and takes you to the main window to view the collection.



Select Treasury

The Select Treasury dialog box allows you to select one or more of the Herman treasuries for viewing. 
Only cartoons from the selected treasuries will be available. Click the treasuries you want to view and 
click the OK button.

Treasury 1 check box selects the cartoons that were published in the first Herman treasury.

Treasury 2 check box selects the cartoons that were published in the second Herman treasury.

Treasury 3 check box selects the cartoons that were published in the third Herman treasury.

Treasury 4 check box selects the cartoons that were published in the fourth Herman treasury.

Treasury 5 check box selects the cartoons that were published in the fifth Herman treasury.

Treasury 6 check box selects the cartoons that were published in the sixth Herman treasury.

Treasury 7 check box selects the cartoons that were published in the seventh Herman treasury.

Treasury 8 check box selects the cartoons that were published in the eighth Herman treasury.

Back button returns you to the first Browse Wizard page.

Select All button selects the cartoons from all of the treasuries.

Finish button accepts your category selection and takes you to the main window to view the 
collection.

{button ,AL(`Browse Wizard')} Related Topics



Select one or more of the treasuries from this group for viewing.



Selects the cartoons that were published in the first Herman treasury.



Selects the cartoons that were published in the second Herman treasury.



Selects the cartoons that were published in the third Herman treasury.



Selects the cartoons that were published in the fourth Herman treasury.



Selects the cartoons that were published in the fifth Herman treasury.



Selects the cartoons that were published in the sixth Herman treasury.



Selects the cartoons that were published in the seventh Herman treasury.



Selects the cartoons that were published in the eighth Herman treasury.



Selects the cartoons that were published in the first Herman treasury.



Selects the cartoons that were published in the second Herman treasury.



Selects the cartoons that were published in the third Herman treasury.



Selects the cartoons that were published in the fourth Herman treasury.



Selects the cartoons that were published in the fifth Herman treasury.



Selects the cartoons that were published in the sixth Herman treasury.



Selects the cartoons that were published in the seventh Herman treasury.



Selects the cartoons that were published in the eighth Herman treasury.



Returns you to the first Browse Wizard page.



Selects the cartoons from all of the treasuries.



Accepts your category selection and takes you to the main window to view the collection.



Slide Show

The Slide Show dialog box allows you specify the number of seconds that you want the slide show to 
wait before displaying the next cartoon and whether you want the cartoons displayed in a full screen 
window. 

Select or type a number in the View Time number box. Enable the Full Screen check box if you want 
to display the cartoons full screen and click the OK button.

View Time number box specifies the length of time that each cartoon will be displayed during the 
slide show.

Cancel button exits from the Slide Show dialog box and returns to the cartoon browse screen without 
starting a slide show.

Full Screen check box specifies that the cartoons will be displayed using the full screen.

OK button accepts the viewing time and full screen setting for the slide show and displays the 
Browse Wizard page to allow you to select the cartoons you want to include in the slide show.

{button ,AL(`Slide Show command menu')} Related Topics



Specifies the length of time that each cartoon will be displayed during the slide show.



Exits from the Slide Show dialog box and returns to the cartoon browse screen without starting a slide show.



Specifies that the cartoons will be displayed using the full screen.



Accepts the viewing time and full screen setting for the slide show and displays the Browse Wizard page to allow you to select 
the cartoons you want to include in the slide show.



About Herman

Displays version information about The Complete Herman Collection’s Reader.



Returns to the Complete Herman Collection.



Right mouse click

If you right click on a Herman cartoon while you're browsing through the cartoons, a menu is 
displayed that provides short-cuts to many of the most commonly used functions in The Complete 
Herman Collection. The short-cut menu allows you to execute the following menu commands: Add To 
Favorite, Browse Wizard, Copy, Print..., Save As..., Save Bookmark..., Load Bookmark..., Slide 
Show..., and Wallpaper. The commands executed from the right mouse button menu function in 
exactly the same manner as if they were executed from the main application menu.

{button ,AL(`Add To Favorite command (Favorite menu);Browse Wizard menu command;Copy 
command (Edit menu);Load Bookmark... command (Bookmark menu);Print... command (File 
menu);Save as... command (File menu);Save Bookmark... command (Bookmark menu);Slide 
Show command menu;Wallpaper command menu')}    Related Topics



How to...

Bookmarks and Favorites

add a cartoon to your collection of favorites
insert a bookmark
load a bookmark
remove a cartoon from your collection of favorites
save your location when you exit

Saving, copying and printing

copy a cartoon to the clipboard
preview a cartoon for printing
print a cartoon
save a Herman cartoon to a Windows Bitmap file
set print options

Slide Show and Wallpaper

change the system wallpaper
start a slide show
stop a slide show

Help

display Help for a specific command
display Help for a specific dialog box
display Help for window elements such as buttons and list boxes
display the version of The Complete Herman Collection that you're using

Miscellaneous

configure the Complete Herman Collection screen saver
exit The Complete Herman Collection
leave The Complete Herman Collection running in the background
view cartoons from a collection



Installing The Complete Herman screen saver

When you installed The Complete Herman Collection software, the Complete Herman screen saver 
was added to the Windows screen saver on your system. This screen saver allows your system to 
display Herman cartoons whenever your system is inactive for a specific length of time.

The screen saver requires that the Herman CD-ROM remain in the drive while the screen saver is 
active. If you remove the CD-ROM, the screen saver displays four default cartoons that it keeps 
available at all times.

To configure the Complete Herman Collection screen saver:

1. Click the Start button on the Windows task bar and choose Settings. 

2. From the Settings menu, choose Control Panel.

3. From the Control Panel, double-click the Display icon.

4. In the Display Properties dialog box, click the Screen Saver tab.

5. From the Screen Saver list box, choose Herman.

6. Click the Settings button.

7. Choose the collection of cartoons you want displayed by your screen saver.

8. Some collections display a second configuration page. Make a selection on the second page and 
click the Finish button. If a second page isn't required, you're returned to the Display Properties, 
Screen Saver tab immediately after choosing a collection.

9. Click the OK button to accept your changes to the screen saver.



The Complete Herman Collection main window

The main window allows you to browse through the collection of Herman comics that's currently 
selected. To move forward in the collection, click the pointing hand in the lower right corner of the 
window. To move backward in the collection, click the pointing hand in the lower left corner of the 
window. If you want to change the collection you're viewing, choose the Browse Wizard menu 
command and choose a new collection of cartoons.

{button ,AL(`Browse Wizard menu command')} Related Topics



About Jim Unger

Jim Unger is the creator of the ever lovable Herman cartoons. He was born in London, England but 
before getting too far through life, he moved to Canada along with his family.

In Canada, Unger found work as a graphic artist creating editorial cartoons at a newspaper. His work 
captured the imagination of the readers and the attention of Ontario Weekly Newspapers’ Association 
which awarded him the Cartoonist of the Year Award for three consecutive years. His success 
continued with his creation of Herman and Unger eventually Escaped from the Canadian climate and 
took up residence in the more hospitable climes of Nassau.

Unger began the series of Herman cartoons in 1974, and while he was unsure of how long he could 
keep the humor flowing, he didn’t stop for twenty years. In that time, Herman's antics appeared in 
hundreds of international newspapers, were translated into many languages, and were enjoyed in 
more than twenty-five countries. Unger's Herman treasuries and books sold millions of copies 
throughout the world and he won several awards from the National Cartoonists Society.

While Unger has allowed Herman to retire from the crazy world of today, this collection of over 5000 
cartoons keeps Herman alive and should keep the rest of us laughing for years to come.




